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 Introduction

 

Welcome to the new and exciting world of DHTML pull-down 
menus!

It has been proven that the easiest way to navigate the different options of any 
interface is through the use of menus. Operating systems and most software 
use menus to allow the user to navigate and find his way around.

So... why shouldn't your web site use menus, too?

DHTML Menu Builder not only creates menus, it creates beautiful menus 
composed of thousands of lines of code compatible with all the major browsers 
and platforms. But don't worry, you don't have to know anything about the 
code that DHTML Menu Builder produces. You can just concentrate on using it 
to spice up your navigation system. Let DHTML Menu Builder do the hard work!

From plain, text-based menus to complex graphical menus loaded with the 
latest DHTML and CSS standards, DHTML Menu Builder can deliver professional-
looking menus that work and feel as if you were using some program on your 
computer.

DHTML Menu Builder's feature-rich options will let you build a navigation 
system just the way you want  it. With support for any kind of web site 
configuration–including sites that use frames, sites that use pre-processor 
languages (such as ASP or PHP), and sites built with any HTML authoring 
application, DHTML Menu Builder is the ultimate site navigation solution.

Did we mention that the menus look cool? The menus created by DHTML Menu 
Builder can be highly customized so that the user will not even notice that the 
navigation system is made up of standard HTML elements!

This documentation will guide you through all of the different parts of DHTML 
Menu Builder and will also help you master the basics needed to easily add 
menus to your existing web site. Please read it carefully... there's a lot of 
important information that will help you set up your navigation system in a 
couple of minutes.

http://software.xfx.net/utilities/dmbuilder/content/tipstricks/tbpos.htm
http://software.xfx.net/utilities/dmbuilder/content/tipstricks/inacell.htm
http://software.xfx.net/utilities/dmbuilder/faq.htm
http://software.xfx.net/utilities/dmbuilder/tipstricks.htm
http://software.xfx.net/uboards/forumredir.php?redir=main
http://software.xfx.net/utilities/dmbuilder/samples.htm
http://software.xfx.net/utilities/dmbuilder/webslist.php


 Introduction

 

Welcome to the new and exciting world of DHTML pull-down menus!

It has been proven that the easiest way to navigate the different options of any interface is through 
the use of menus. Operating systems and most software use menus to allow the user to navigate and 
find his way around.

So... why shouldn't your web site use menus, too?

DHTML Menu Builder not only creates menus, it creates beautiful menus composed of thousands of 
lines of code compatible with all the major browsers and platforms. But don't worry, you don't have to 
know anything about the code that DHTML Menu Builder produces. You can just concentrate on using 
it to spice up your navigation system. Let DHTML Menu Builder do the hard work!

From plain, text-based menus to complex graphical menus loaded with the latest DHTML and CSS 
standards, DHTML Menu Builder can deliver professional-looking menus that work and feel as if you 
were using some program on your computer.

DHTML Menu Builder's feature-rich options will let you build a navigation system just the way you 
want  it. With support for any kind of web site configuration–including sites that use frames, sites that 
use pre-processor languages (such as ASP or PHP), and sites built with any HTML authoring 
application, DHTML Menu Builder is the ultimate site navigation solution.

Did we mention that the menus look cool? The menus created by DHTML Menu Builder can be highly 
customized so that the user will not even notice that the navigation system is made up of standard 
HTML elements!

This documentation will guide you through all of the different parts of DHTML Menu Builder and will 
also help you master the basics needed to easily add menus to your existing web site. Please read it 
carefully... there's a lot of important information that will help you set up your navigation system in a 
couple of minutes.



 Getting Started

The following sections explain the basics of preparing your menu project. 
Here, you will also learn about all the components that make up a menu system and the styles that can 
be used to customize each and every one of these components.

Please select the section you would like to read about. We recommend that first time users read all of 
the topics in the order presented below.

●     Preparing Your Web Site
●     Project Properties
●     Creating Menus

 

 



 Preparing your Web Site

Depending on the type of menus you're going to build, certain preparations need to be made to your 
web site. 

DHTML Menu Builder can be used to create a toolbar, or you can create menus which appear using 
elements that already exist on your web pages.

If you're going to use a toolbar created by DHTML Menu Builder, there's no need to do any additional 
preparations to the pages on your web site and you may continue to the next section:  Project 
Properties

Using your own text and graphics

One of the most unique features of DHTML Menu Builder is the ability to attach menus to text or 
graphics which you have already placed in your web pages. 
This feature lets you build your own custom toolbar using your favorite image editing program, and 
then have the menus react when the user activates an element from your toolbar. It is important to 
understand that the toolbar is the only element of a menu that is always visible to the user and its 
design should be consistent with the general layout and design of your web site.

When using your own toolbar, you need to set up each hotspot in a special way so than DHTML Menu 
Builder can later attach the menu groups to them. This setup is known as converting the hotspots into 
null hyperlinks.

Converting your hotspots into null hyperlinks

A hotspot can be an image or just some text. To convert your hotspot into a null hyperlink, simply 
create a hyperlink on that element and make it point to itself; this is done by using a hash (or pound 
sign) character "#" as the target of the link.

  

  

Let's say this is one of the images you're going to use to display a menu. 

The HTML code of the image looks like this: 
<img border="0" src="images/sample_image.gif" align="middle" width="50" height="33">

 



  

  

After converting the image into a null hyperlink the code looks like this: 
<a href="#"><img border="0" src="images/sample_image.gif" align="middle" width="50" 
height="33" name="MyImage"></a> 

As you can see, by moving the mouse over the converted image, your mouse changes into a 
hand indicating that the image is a link. Highlighted in dark red you can see the code that 
converted the image into a null hyperlink. Also note that we have added a new setting, 
name,  to the image's code. The name setting will allow DHTML Menu Builder identify the 
image and perform automatic alignment of the menus. You should give each image-based 
hotspot a unique name so DHTML Menu Builder can identify it.

This is all the preparation that needs to be done, so when you are ready to implement your menus into 
the page that contains the toolbar, everything will be ready to use the HotSpots Editor and 
automatically make your hotspots active and responsive to users' actions.

Once you have your web site prepared with all your hotspots converted into null hyperlinks, you can 
now move to the next section and start preparing your menus in DHTML Menu Builder: Project 
Properties

Related topics of interest: 

●     Creating Toolbars
●     The HotSpots Editor



 Project Properties

Every menu system you create with DHTML Menu Builder is stored in a  project file with a DMB 
extension.

Many settings affect your entire project; these are set through the pages of the Project Properties 
dialog.

To access the Project Properties dialog, follow any one of the following steps:

●     From the File menu, choose Project Properties.
●     Press the CTRL+P shortcut
●     Click the Project Properties icon  on the toolbar

The Project Properties dialog is divided into 5 main sections. Along with their main purpose, they are 
listed below:

●     General: specify your project's name and location of the project files. 

●     Configurations: specify the location of your web and the JavaScript files DHTML Menu Builder 
needs to implement the menus . This section is also used to set up frames support. 

●     Global Settings: change several settings that affect the whole project.

●     Advanced: change some of the advanced options of your project (e.g. type of optimization to 
be applied to the generated code files).



 Configurations

The final process of implementing a menu system with DHTML Menu Builder involves the ability to save 
the menus in a folder on your computer. 
To do this, DHTML Menu Builder needs to know where to save the compiled JavaScript files and the 
images that your menus use.

To access the Configurations editor click File->Project Properties->Configurations

By default, when you create a new project DHTML Menu Builder will create a new configuration called 
"Default". 
Bellow is a list of the settings that need to be made:

●     Local Path to the Root Web 
This is the route or path to the folder containing your main HTML page. Typically, this is index.
htm, default.htm, index.html or default.asp. 
Always avoid typing the path manually; use the browse button  to select the folder and avoid 
typographical errors.

●     Folder to Store Compiled Files 
This setting must point to a folder inside your root web where you will store the JavaScript files 
compiled by DHTML Menu Builder. These files are the scripts that build and handle the menus. 
Again, always avoid typing the path manually and use the browse button  to select the folder 
and avoid typographical errors.

●     Folder to Store Images 
This path is where you want DHTML Menu Builder to store the images files used by your 
menus. This folder must also be inside your root web. 
As always,  avoid typing the path manually and use the browse button  to select the folder 
and avoid typographical errors.

DHTML Menu Builder needs some additional information about your web site and the files in it. 
For example, if your site uses frames you will have to set up frames support and specify the necessary 
settings related to frameset structure of your web site.

Another group of settings will let you use the HotSpots Editor to automate the process of inserting the 
code necessary to run the menus on your web site.

Setting up the document that will trigger the menus

Besides the standard path settings described above, each configuration must have information about 
the document on your web site that will be used to trigger the menus. The menus can be triggered 
from the toolbar created by DHTML Menu Builder or through the use of HotSpots.

NOTE: This file will be modified by DHTML Menu Builder to include all the code necessary to make the 



menus work. It is a good practice to always keep a backup copy of this file.

As you can see, DHTML Menu Builder gives you the option to install the menus onto a single file. 
However, you may want to install the menus on all the files on your web site, and there are several 
ways to this: 
Ideally you should install the menus onto a single file and then share this file across all the other 
documents on your web site. 

●     Some applications, such as Macromedia's Dreamweaver let you create a template from which all 
the documents on your web site inherit their style. This template is where you should install the 
menus so every time you create a new document it will automatically inherit the code that loads 
the menus. For more information about templates, consult your Dreamweaver documentation.

If your HTML editor does not support templates you could then use some sharing technique that is 
either supported by your web server or your HTML authoring application. 

●     For example, Microsoft's FrontPage supports something known as the Page Inclusion 
component. This component allows you to include a page inside another page. For more 
information about the Page Inclusion component, consult your FrontPage documentation.

Finally, many web servers support SSI or Server Side Includes. To know if your web server supports 
this feature and for information on how to use it, consult your web server's documentation or ask your 
server administrator.

Setting up your project to support frames

DHTML Menu Builder has 100% support for implementing the menus on web sites that use frames. 
A common issue when using frames is that most of the time the menus will not fit on the frame where 
you have designed the toolbar. The only solution, since it's not possible to display anything above the 
division of two frames, is to have the menus appear on another, larger frame.

More information about the setting up your menus to work with frames.

Related topics of interest: 

●     Implementing the Menus

 

 

 





 Creating Menus

A  DHTML Menu Builder menu is comprised of three items: 

●     Groups 
The groups are containers and control the space used to hold commands and separators. 

●     Commands 
These are the basic items of your menus. The commands are the options that user selects to 
navigate through your web site using the menus. 

●     Separators 
The separators are a special kind of command whose only purpose is to create a separation, 
with a thin line, between two commands.

In other words, a Project is made of menus. Each menu is made of groups that contain commands and 
separators. 
The illustration below diagrams this relationship:

Since it is the most general item, the project controls the way the menus will work on your web site. 
The group is a container; it controls the background color, images and borders of the menus. The 
commands control the actions of the menus; the color and font used by the menus is also controlled at 
this level.

Of course, these are just the most basic settings of each item. Later on in this Help, you will find that 
DHTML Menu Builder provides unprecedented formatting options to let you make your menus look 
exactly they way you want them to appear.

Adding, Renaming and Deleting Groups 

After a  project is created, you must next create a group. Once you have created a group, you will then 
be able to add commands and separators to it and this will complete the creation of a menu. 



A project can have as many menus as you need. 

To add a group, do any one of the following steps: 

●     On the Menu menu, click Add Group.
●     Press the F6 shortcut key.
●     Click the Add Group icon  from the toolbar.

When you create a group, DHTML Menu Builder will add an entry in the left side of the main window 
and will wait for you to type a name. This name is an internal reference for DHTML Menu Builder and is 
independent of the actual caption of the added item. Both the name and the caption can be the same 
if you wish.

After entering the name of the group, DHTML Menu Builder will auto fill the Caption property for you. 
Change it if you need to. The Caption is the actual text that will be displayed when your menu is 
viewed with a browser.

To rename the group, just select it and then choose Rename from the Edit menu. Alternatively, 
after selecting the group name, you can also press F2 or just click it again (after a short pause so it is 
not interpreted as a double-click) and you can edit in place. Note that if you have already set the 
caption for a group, DHTML Menu Builder will not update its caption when you rename the group.

To delete a group, select it and then choose Delete from the Edit  menu.  
It is important to note that when you delete a group, you will always delete any command(s) created 
under it. This is because groups are containers that hold commands; if you delete the container, all the 
commands under it are deleted as well.

To learn more about groups, click here.

Adding, Renaming and Deleting Commands

In order to create commands, you need to have at least one group in your project. 
Each command represents an option in your menu. Commands can have actions associated with them 
to perform functions when a user activates them with the mouse.

A command can instruct the browser to open a page (and optionally to display it in a new browser 
window), to send an email,or to display another group and create what is known as a submenu.

To add a command, do  any one of the following steps: 

●     On Menu menu, click Add Command (or click Add Separator to add a separator).
●     Press the F7 shortcut key (or press the SHIFT+F7 shortcut key to add a separator).
●     Click the Add Command icon  from the toolbar (or click the Add Separator icon  to add a 

separator).



Right after the command entry has been added, DHTML Menu Builder will let you name the command. 
Again, this name is just an internal name used by DHTML Menu Builder and is not the actual text that 
will be displayed on the menus when these are viewed on your web site with a browser. To change the 
text to be displayed for this item, just change the caption.

To rename a command, just click over it to select it and then select Edit form the menu and then 
Rename. 
Note that if you have already set the caption of this item, DHTML Menu Builder will not update its 
caption.

To rename a command, just select it and then choose Rename from the Edit menu. Alternatively, 
after selecting the command name, you can also press F2 or just click it again (after a short pause so it 
is not interpreted as a double-click) and you can edit in place. Note that if you have already set the 
caption for a command, DHTML Menu Builder will not update its caption when you rename the 
command.

To delete a command, select it and then choose Delete from the Edit  menu. 

To learn  more about commands click here.

 



 Groups

Groups are containers for the commands (items) on a menu. They are responsible for specifying 
attributes such as background color, frame thickness and color, margins, etc.

Listed below are the attributes of groups and specific information about each one: 

●     Back Color 
To change the background color of a group, select the group. Then, on the Menu menu click 
Color. 
You can also change the background color of a group by accessing the Image dialog. With the 
image dialog you will have many more options to customize the look of your group and select 
more properties from the dialog. (See Image below). 

●     Font 
A group can define the default font used by its commands. When you change the font on a 
group, newly created commands will inherit this setting. 
Also, when using toolbars, this will be the font used to represent this group. 
To change the font of a group, first select the group. Then, on the Menu  menu click Font. 

●     Cursor 
You can make the mouse pointer change when a user moves the mouse over a hotspot, 
whether it is a hotspot created by you or a hotspot from the toolbar created by DHTML Menu 
Builder. 
To change the cursor of a group, fist select the group. Then, on the Menu menu click Cursor. 

●     Image 
Groups support several types of images: 

●     Back Image 
This is the image used in the background of the container. 
When using images in the background of the groups, the commands will not display the 
normal background color. If they did, this color would cover the image producing an 
undesirable effect. 

●     Border Size and Colors 
Groups are containers. You can customize the borders. 
The border size setting will let you adjust, in pixels, the width of this container. The color 
settings let you customize the color of each one of the four borders.

When using the toolbar created by DHTML Menu Builder, you have the option to specify images 
for your groups to be placed at either or both sides of the group's caption. 
For more information, check the Creating Toolbars section. 
To change any of the above settings for a group, select the group. Then, on the Menu menu 
click Image. 

●     Leading 
This setting controls the vertical spacing between the commands in the group. 



●     Margins 
This setting controls the distance from the group's borders to its contents. 

●     Selection Effects 
The settings in this section affect the commands under the selected group and control the style 
and color of the bounding rectangle of the menu items. 
Also, if the selected group is going to be displayed on a toolbar, these setting will also affect the 
toolbar item.

●     Normal and Over 
These settings change the border of the commands when the mouse is  over (Over 
state) and not over (Normal state). 
You can choose from three different types of border effects: 

●     (none): No border will be drawn.
●     Raised: A border will be drawn which has the effect of raising the command 

towards you.
●     Sunken: A border will be drawn which has the effect of insetting the border into 

the group's background.
●     Double: Two two solid borders will be drawn around the command.
●     Bevel: Two borders – one raised and one sunken, each half the size of the total 

border width – will be drawn around the command.
You can also define the base color that will be used to draw these borders by using the 
color selection boxes next to the border style controls. 

●     Border Size 
This setting creates a border of the specified width around the commands. 

●     Horizontal and Vertical Margins 
These settings control the distance from the border of the commands to their contents.

●     Special Effects 
The special effects dialog is divided into two sections: 

●     Group Size 
By default, DHTML Menu Builder measures the contents of the group and determines 
the optimal width and height of the group so that the contents fit into it. 
However you can manually adjust these values using the controls on this dialog:

●     Auto: The program will calculate the width and height automatically based on 
the item's contents. This is the default setting.

●     Background Image: The width or height of the item will be set to the size of 
the background image.

●     Manual: DHTML Menu Builder will accept the numbers (in pixels) that you enter 
here These numbers will define a specific width or height for the group. Note that 
defining a value that is too small will cause unpredictable results and will 
incorrectly render the contents of the group. Click the Calculate button to let 
DHTML Menu Builder calculate the recommended size of the selected item.

●     Group Effects 
This dialog will let you define some special effects for the selected group:

●     Drop Shadow Color: Move the slider towards the right to increase the darkness 



of the shadow displayed behind the selected group. 
●     Transparency: Move the slider towards the right to increase the transparency of 

the group and its contents. This will reveal whatever contents are underneath the 
group.

●     Context Menu: Check this option to make the selected group the context menu 
for the browser. This means that when a user right clicks a page, the selected 
group will be displayed instead of the browser's default context menu.

Note that the Drop Shadow and Transparency effect will only work for those using 
Internet Explorer 5.5 (or above) for Windows. 

●     Commands Layout 
This setting controls the way the commands are aligned inside a group :

●     Vertically (default): Commands will be placed one below the other creating a 
standard dropdown menu.

●     Horizontally: Commands will be placed one next to the other creating a wide menu. 
These kind of menus are ideal when there's not enough vertical space to display a menu.

To change any of the Special Effects settings of a group, select the group. The on the Menu 
menu click Special Effects. 

When the project uses a toolbar, groups are also treated as commands since they will be rendered 
inside a toolbar and will have properties and behaviors very similar to those that only apply to a 
command. Continue to read the information about commands as it will become handy when using the 
toolbar feature of DHTML Menu Builder.

Related topics of interest: 

●     Commands
●     Anatomy of a Menu
●     Copying and Pasting Styles
●     Creating Toolbars
●     Incompatibilities and limitations
●     Style Dialogs



 Commands

The commands are the basic components of your menus. They represent the options to display on the 
menus so the users can navigate to them. 

Commands usually perform some action when activated by a user. They may be activated by moving 
the  mouse over them, clicking the left mouse button on them,  by double-clicking them,  or by using 
combinations of the three available actions.

The type of actions a command can produce are countless, but DHTML Menu Builder provides an easy-
to-use interface to let you implement the most common:

●     Opening a page (following a link).
●     Opening another group (this is used to create submenus).
●     Opening a page in a new browser window.
●     Sending email.
●     Running a small piece of code written in JavaScript or VBScript.

There are two types of command components:

●     Commands 
These are items that receive and perform actions 

●     Separators 
These are simple lines used to separate commands inside a group. Separators do not receive or 
perform any kind of actions.

Commands are dual-state items and therefore have (for the most part) two settings:

●     Normal 
The settings in this mode apply when the command is not selected. 

●     Over 
The settings  in this mode apply or become active when the mouse is over the command. 

Below are all the possible attributes supported by a command. 

●     Color 
You can assign a background color and the color of the command's caption text. 
This setting supports two sets of two color definitions: background over and background 
normal; and text over and text normal.

●     Font 
This setting controls the font type, size, and style used to display the command's caption text. 
You can apply different font settings for the two modes, Normal and Over.



●     Cursor 
One of five predefined cursors can be set to display when a user moves his mouse pointer over 
a command. 
To change a command's cursor, select the command. Then click Menu on the menu and click 
Cursor. 

●     Image 
Commands support three types of images, one  image to the left of the caption, one  image to 
the right of the caption, and one image  as the background. 
The two images that can be placed at the right and/or left of the commands support rollover 
effects. This means that you can change either image when the command is selected. 
Note: When using a background image, the color on the Normal state is not used and the 
command is rendered as transparent.

●     Selection Effects 
The settings in this section control the style and color of the bounding rectangle of the menu 
items.

●     Normal and Over 
These settings change the border of the commands when the mouse is  over (Over 
state) and not over (Normal state). 
You can choose from three different types of border effects: 

●     (none): No border will be drawn.
●     Raised: A border will be drawn which has the effect of raising the command 

towards you.
●     Sunken: A border will be drawn which has the effect of insetting the border into 

the group's background.
●     Double: Two two solid borders will be drawn around the command.
●     Bevel: Two borders – one raised and one sunken, each half the size of the total 

border width – will be drawn around the command.
You can also define the base color that will be used to draw these borders by using the 
color selection boxes next to the border style controls. 

●     Border Size 
This setting creates a border of the specified width around the commands. 

●     Horizontal and Vertical Margins 
These settings control the distance from the border of the commands to their contents.



Related topics of interest: 

●     Groups
●     Anatomy of a Menu
●     Copying and Pasting Styles
●     Creating Toolbars
●     Incompatibilities and limitations
●     Style Dialogs
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